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Chapter One: 
 

Welcome to Microsoft Expression Media 
 

Microsoft® Expression® Media is the fast and easy way to view, organize, and present the 

growing number of images, movies, sounds, fonts, and other media files that reside on your 

various disks. Whether you are a student, journalist, multimedia enthusiast, or creative 

professional, it is important to be able to organize and browse your images, movies, documents. 

Then you can modify and professionally present them in nearly any multimedia or document 

format that you want. 

System requirements 
This section lists the minimum system requirements for Expression Media (with the 

recommended ones in parentheses). It is important to have the most recent version of Apple® 

QuickTime®. This will improve the performance and functionality of Expression Media. 

 

Microsoft Windows 

¶ Intel® Pentium® III 500 MHz processor or equivalent (Intel Pentium 4) 

¶ 1 GB of RAM 

¶ 1024 x 768 display with 24-bit color 

¶ 100 MB of hard disk space for installation  

¶ Microsoft® Windows® XP (XP SP2) or Windows VistaÊ 

¶ Apple QuickTime 7.1.5 or higher 

¶ Microsoft® Internet Explorer® 5.5 (6.0) and higher  

¶ DirectX 9.0c  

¶ Adobe® Reader® 7.0 or higher for PDF file support 

Apple Macintosh 

¶ Expression Media supports Intel®-based Macintosh  

PowerPC® or Intel Core Processor 

¶ DVD-ROM drive 

¶ Apple® Macintosh® OS X (10.4.8 or later) 

¶ Apple QuickTime 7.1.5 or later 

¶ Monitor set to Millions of Colors 

¶ 100 MB of hard disk space for installation 

¶ 512 MB of RAM or more 
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Installing Expression Media 
There are slightly different methods for installation, depending on the operating system you are 

using. After installation, you will need to type in the product key. 

 
To install Expression Media on Windows 

1. Insert the Expression Media CD or DVD.  

2. Click Install Expression Media, and then follow the instructions. 

Note: If this menu does not appear, your PC might not support AutoPlay. In this case, 

open the CD or DVD and run Media.xx.exe, where xx is the country code.  

To install Expression Media on the Macintosh 

1. Insert Expression Media. 

2. Double-click the Install Expression Media icon, and then follow the instructions.  

To change languages on the Macintosh  

1. Open the application. 

2. Click the Expression Media icon. 

3. On the File menu, click Welcome Screen.  

4. Expand the Languages menu. On installation, Expression Media defaults to the operating 

system language. To run in a different language, clear all languages except the one you 

want to use.  

To change languages in Windows 

When you install Expression Media, you select a language. To change languages, reinstall 

Expression Media, and then select an alternate language from the menu. 

 
To enter the license key 

1. After you have installed Expression Media, start the application.  

2. On the Help menu, click Welcome Screen.  

3. On the Edit  menu (Macintosh: Application  menu), click Preferences.  

4. Type your product key from the back cover of the package.  

Installing plug-ins 

The installation creates a Plug-ins folder that contains files that are important to the applicationôs 

functionality. Knowing the location of this folder is important so that you can customize or 

install additional functionality, such as HTML themes, print templates, importers, and scripts. 

Location of the Plug-ins folder on Windows 

The user-defined Plug-ins folder is located in one of two locations: 

¶ C:\Documents and Settings\username\Application Data\Expression Media\Plug-ins (XP) 

¶ C:\Documents and Settings\username\Application Data\Roaming\Expression 

Media\Plug-ins (Windows Vista) 
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Note: On some Windows operating systems, the Application Data folder might be hidden. If so, 

consult your operating system Help for assistance in showing hidden folders. 

Location of the Plug-ins folder in Macintosh  

On the Macintosh, there is a folder that is split between built-in plug-ins, which are located 

inside the application package, and user-installed plug-ins, which can be in any of the following 

three locations: 

¶ ~/Library/Application Support/Expression Media/Plug-ins 

¶ ~/Network/Library/Application Support/Expression Media/Plug-ins 

Language support 

By default, Expression Media uses the language of the operating system or remembers the last 

language used. For information about how to change the language used by Expression Media, 

see ñInstalling Expression Mediaò on page 2. 

Web resources 

You can access additional resources for learning Expression Media on the Expression Web site. 

Tutorials, customer support, forums, and application updates are available online. Go to the Web 

site at http://go.microsoft.com/fwlink/?LinkID=82546 

Adding media importers  
Expression Media can use any QuickTime-based media importer. Download and install the 

importer. You can download additional importers from third-party sources on the Web.  

Scripting  

Expression Media is scriptable and can be easily integrated with third-party applications to 

perform workflow automation.  

Scripting on Windows  

Expression Media supports Visual Basic® Script and JavaScript automation. Once you create 

scripts, you can attach them to the application for access through the Scripts menu. For 

instructions about creating scripts with Expression Media (at the Expression Media AppleScript 

dictionary from within Script Editor), refer to the Expression Media Web site. 

Scripting on the Macintosh 

Expression Media supports AppleScript®, and the scripts are attachable to the application 

(accessible from the AppleScript menu). To get started with scripting in Expression Media, visit 

the Expression Media Web site, and then refer to the AppleScript examples. 
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Chapter Two: 
 

Microsoft Expression Media Basics 
 

 

Before you get started with Expression Media, there are some basic concepts that you need to 

know about how Expression Media imports, lists, and categorizes files. This chapter reviews the 

tasks necessary to create and work with your first catalog. 

 

 

 
Microsoft Expression Media interface 

 

 

 
Access most of the major functions of Expression Media by clicking buttons on the toolbar  

 

How Expression Media works 

Microsoft Expression Media stores information about media files in catalogs. A catalog is a 

visual database that you can organize and search. A catalog contains information about each file 
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that is relevant to the media type (attributes). 

Tags (also called annotations or metadata) that help you organize and classify media are: 

¶ A thumbnail of each media file. 

¶ A full screen preview of each media file (if this option is selected). 

¶ The location (path) of the original file on a hard drive, CD, or other kind of volume. 

You can create as many catalogs as you want, depending on how you want to organize your 

media files. For example, your photos, videos, and music could each have their own catalog file. 

Or, you could create one catalog containing all your media. Each catalog can contain up to 

128,000 files with a 1.8 GB limit. 

 

Once you have created a catalog, you can store your images with digital camera information, 

captions, labels, and annotations, and then search and browse the catalog, even if your original 

files are misplaced or offline.  

 

Also within Expression Media, you can edit all of your media files, including renaming, image 

editing, managing color profiles, printing contact sheets, changing file formats, and creating slide 

shows. 

Working with catalogs 

The first time you launch Expression Media, youôll see a Welcome Screen. This dialog box helps 

you get acquainted with the Expression Media features, and assists you with import options for 

creating new catalogs. If you have an idea of how you want to organize your catalogs, you can 

let Expression Media create your catalog for you when you select one of options in the dialog 

box. For more information about these import options, see ñFiltering imports by media typeò on 

page 8.  

 

If you want to learn more about cataloging and the options that you have before you, create a 

catalog, close the dialog box and see ñCreating catalogs and importing mediaò on page 8 for 

more information about understanding and creating catalogs. If you want to access this dialog 

box later, you can find it in the Welcome Screen menu on Windows, and in the Expression 

Media application menu on the Macintosh.  

Understanding catalogs 

When you add files to a catalog, Expression Media stores a thumbnail version of each file, as 

well as information about the file, including its location on your disk or on the removable storage 

disk from which you might have imported the file. When you are working with your cataloged 

media, remember the following: 

¶ You can search and organize Expression Media catalogs, even when your original files 

are not present. For example, your original files might be stored on a CD that is not on 

the computer. However, in the catalog, you can still view the thumbnails and 

information pertaining to those files. 

¶ Because the original files are not embedded in the catalog, Expression Media cannot 

display them in larger sizes. You need access to the original files.  
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¶ If you delete a media file on the desktop or a disk, it cannot be recovered through an 

Expression Media catalog. A catalog contains only information about the file, and not 

the file itself. 

¶ Adding files to an Expression Media catalog does not move or modify the original 

media. 

Cataloging strategies 

A common question in digital asset management is: ñShould I put all of my media into one big 

catalog or into several smaller catalogs?ò The number of catalogs that you create varies, 

depending on your workflow and the types of media you are tracking in catalogs. Anything that 

is logical and fits well into your specific workflow needs is acceptable. Expression Media 

catalogs are designed to contain up to 128,000 media items with a limit of 1.8-GB limit. 
 

It is possible that a single catalog will be sufficient for your needs. However, grouping files into 

a few separate catalogs creates a higher level of organization and search capabilities.  

 

Here are some ways to organize your catalogs: 

 

Organize by project  Dedicate a catalog to each of your projects or clients for easy and quick 

reference. This is also is a good method for supporting short-term deadlines and goals. 

 

Organize by chronology  Create an additional set of catalogs based on the date and time. It is a 

good monthly habit. It will help you build a searchable archive as you go. Expression Media 

features a way to import one catalog into another, so, for example, you can create a single 

catalog for July and subsequently import all of the separate catalogs from all your July projects 

into that single catalog. 

 

Organize by subject  Any logical subjects that are not likely to overlap are a good way to divide 

your media into multiple catalogs. For example, you can store your images by high-level subjects 

that describe the types of your photo assignments, such as travel, fashion, portraits, and so on. 

 

Organize by process/task  At times, there are clearly definable states for files in a workflow. 

Separating items by their state or task in your workflow can help direct users to the media item at 

the correct stage in the workflow. For example, if photographers want to track files through a 

raw workflow, they might create one catalog each for the original raw files, client selections, 

processed .tif files, and edited images. 

 

Organize by file type  You might want to group files into catalogs based on file type, such as 

music, movies, fonts, illustrations, or a .pdf file. For example, you might want to create a catalog 

of all your fonts, creating a searchable inventory of typefaces available for your design projects. 

 

Organize by search  Expression Media has special search criteria that enables searching across 

all catalogs in a particular folder. Therefore, if you store your entire job catalogs in a defined 

folder, files will be easy to locate. Higher-level chronological catalogs will also be good for 

locating media files. 
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Before creating catalogs and importing media 
There are a few options that you might want to set before creating a catalog. These options help 

you save time and improve the quality and accuracy of your imports. 

Define thumbnail creation and media preview options 

Expression Media assigns a thumbnail image to each imported media item and then stores this 

image in the catalog file. You can choose how large this thumbnail will be. Depending on your 

preferences and the media type, Expression Media assigns each media item. 

 

¶ The embedded thumbnail image created by a digital camera or software program 
These thumbnails are typically low quality.  

¶ A thumbnail created by Expression Media  Use this option for the highest quality 

thumbnails. 

¶ A generic media icon  Some non-image files, such as audio files, have a generic media 

icon assigned to them as a thumbnail image. 

 

You can also define media preview options. These previews are large .jpg proxy images that will 

be displayed in Media View, Slide Show, and Light Table, regardless of whether original media 

files are available for display. Media previews are particularly useful if the majority of your 

media is stored in offline storage, such as on a CD or DVD. These previews are also useful for 

distributing catalogs without including the original media files.  

 
To define thumbnail creation options 

1. Start Expression Media. 

2. On the Edit  menu, click Thumbnails and Previews. 

3. Do one of the following: 

¶ If you want Expression Media to build a thumbnail image, select a size from the 

Thumbnail Size menu. If you select Variable size, Expression Media creates 

thumbnail images matching the thumbnail size defined in the Thumbnail View of the 

active catalog. 

¶ If you want Expression Media to use the embedded thumbnail images created by your 

digital camera or your digital imaging program, select Use built-in thumbnails. 

4. Select a Quality  setting. 

 
To define media preview options 

1. On the Edit  menu, click Thumbnails and Previews. 

2. Select Create full screen previews.  

3. Select a size. 

4. Select the .jpg compression quality to be applied to the preview images, and then  

click OK . 

Note: Catalogs with full screen previews will be considerably larger than catalogs with 

only thumbnails.  
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Filtering imports by media type 

8 control which media files are added to a catalog. Most import options are conditional to the 

type of import (From Folders, Camera, and so on) and you can select those options when you 

initially import files. However, there is a global option to limit importing just those files that 

belong to a certain media type.  

 
To define a media type filter 

1. Start Expression Media. 

2. On the File menu, click Catalog Importers.  

3. Select the box for each media group that you want to allow Expression Media to import 

or ignore in future catalogs. For example, when using Importing from Files/Folders, 

you might select only the Images option to import images such as .jpgs, .tifs, and so on, 

and skip all other files in the same folder. If you are not familiar with which types of 

media files belong to each group, you can select the box for a particular media group to 

see a comprehensive list of all supported media types.  

Supported file formats 

Expression Media can organize more than 100 media file formats. The capacity to import certain 

fil e types is dependent on having the most current version of Apple QuickTime installed on your 

computer. You can download QuickTime for no cost at the Apple Web site. 

 

There are variations of file format support between the Windows and Macintosh platforms. For a 

complete list of supported formats, see ñAppendix B: Supported File Formats.ò 

Creating catalogs and importing media 
There are several ways to import or add media files to an Expression Media catalog, each one 

tailored for a particular circumstance. The basic method is to create a catalog from any file or 

folder that you can access from your computer, including networked folders and removable 

media. However, you can import by dragging and dropping files, as well as using other methods. 

Importing items from files and folders  

This method is the most direct way to import entire folders or drives into catalogs.  

 
To create a catalog from files or folders 

1. Start Expression Media. 

2. Do one of the following and navigate to the files you want to import: 

¶ On the File menu, point to Import Items , and then click From Files/Folders. 

¶ On the Help menu, point to Welcome Screen, and then click Import  from a folder 

you choose.  

3.  If you want to limit the files that you import, refine the Import criteria.  

4. In the File name box, type a file name.  

5. Select Size or Modified to select options that limit the import according to your chosen 

criteria. Selecting the Flat folder search option will constrain folder imports to only the 
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folder level selected and ignore all subfolders (Macintosh).  

6. While your media is being imported, Expression Media will temporarily display a 

progress indicator panel. To stop an import, click the Cancel icon next to the progress 

bar. To hide or show the progress indicator panel, click the Show/Hide Progress icon , 

which is located in the lower-right corner of the catalog window. 

7. Save the catalog. Project catalogs are named chronologically to maintain proper order on 

the desktop. They are stored in a single folder for cross-catalog searches. 

Importing Items by dragging and dropping 

You can drag any file, folder, hard disk, CD, or other volume onto an open Expression Media 

catalog. You can also drop files onto the Expression Media icon or shortcut icon. And you can 

use the drag-and-drop operation on a folder that contains some files already cataloged and a few 

new files. Expression Media ignores the files already in the catalog and adds only the new files 

to the catalog.  

Importing items from pictures/movies folders 

Expression Media automatically finds the Pictures and Movies folders for the active operating 

system user and imports all media into a new catalog. This importing feature works only on the 

operating systems Macintosh OS X, Windows XP, and Windows Vista. 

 
To import items from the pictures/movies folders 

1. On the Help menu, click Welcome Screen. 

2. Select Import Pictures/Movies Folders, and then click Continue.  

Note: Expression Media ignores media in folders dedicated to certain applications, such as 

Apple® iPhoto®. 

Importing items from Spotlight Query (Macintosh) 

Expression Media can import items from your computer using Apple® Spotlight®. When you 

search by using Spotlight, youôre accessing a comprehensive, constantly updated index that sees 

all of the metadata inside supported files on your hard drive, including the kind of content, the 

author, edit history, format, size, and much more.  

 

Most documents, including Microsoft Word documents, Adobe PDF documents, MP3 audio files 

and digital camera images already contain rich metadata. And because Spotlight indexes contents 

of the file as well, your search results include what appears inside a file or document, not just its 

title. 

 
To import items from a Spotlight Query 

1. From Spotlight Query, choose Import Items .  

2. Type a word or phrase to search for, and Expression Media will import all related media 

files.  

3. You can also type a Spotlight Query, using a special Spotlight syntax, to specify complex 

search criteria. 

4. By default, Spotlight imports are appended to the open catalog.  
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5. To place all imported items in a new catalog, select Add results in new catalog. 

Importing items from contextual menus 

You can add items to an Expression Media catalog by selecting an item stored anywhere on your 

computer.  

 
To import items by using contextual menus 

1. Locate an item on your desktop or anywhere on your hard drive and then right-click 

(Windows) or CTRL-click (Macintosh). 

2. Click Expression Media Import from the contextual menu. Items will be added to the 

open catalog or a new catalog, if one is not currently open. 

 

Importing items from Apple iPhoto (Macintosh) 
 

You can transfer all of your files from Apple® iPhoto® to a catalog in Expression Media. The 

new catalog will initially contain references to the photography files that are still inside the 

iPhoto library folders, but you can move those files from iPhoto. The new Expression Media 

catalog also contains your iPhoto albums as Expression Media catalog sets (for more 

information about catalog sets, see ñCatalog setsò on page 66). In addition, your catalog includes 

any metadata (such as EXIF digital camera data, comments, or keywords) that were assigned to 

your images in iPhoto. The following table shows how iPhoto annotations map to Expression 

Media annotation fields. 

 

iPhoto* Expression Media 

File name File name 

Title Title 

Keyword Keyword 

Checkmark (keyword) Does not map at this time 

Star ratings* Do not map at this time 

Albums Catalog sets 

Smart Albums* Catalog sets  

Comments  Description (Caption) 

Date Event Date 

Date (modified in iPhoto) Event Date 

 

* Apple iPhoto 4.0, 5.0 

 

To import items from iPhoto 

1. On the Help menu, click Welcome Screen. 

2. Click Import iPhoto Library .  

Expression Media automatically finds the iPhoto library for the active operating system 

user. 

3.  Launch iPhoto in the background and import all original photos into a new catalog.  

Note: This feature only works with iPhoto versions 2.0, 4.0, 5.0, and 6.0. 

4. If you want to move the newly imported files out of the iPhoto library, select all of the 
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images in the new catalog, and then, on the Action menu, click Transfer to Folder.  

5. In the Transfer to Folder dialog box, select Move files, reset paths, delete originals.  

This moves your original images to a folder of your choice, sets the paths to the new 

location, and deletes the images from the iPhoto library.  

6. To free up additional hard-drive space, you can delete all the thumbnails created by 

iPhoto. To do this, delete the iPhoto Library folder from the Pictures folder.  

Make sure you do this after you have transferred all original images to a new location on 

your hard drive. Alternately, you could leave the original images where they are and have 

media in both iPhoto and Expression Media.  

Importing from a catalog file (merging catalogs) 

Expression Media can combine the contents of one catalog with the contents of another. You can 

do this by either using a menu command, or by using a drag-and-drop operation. If an itemôs 

thumbnail in an older catalog is smaller than the catalog being appended, then you will need to 

rebuild the thumbnail to match the new size.  
 

To merge catalogs 

1. Open an existing catalog. 

2. On the File menu, point to Import Items , and then click From Catalog File. 

3. Navigate to and select a catalog created by an Expression product.  

Note: This function will not work with catalogs created by other programs. 

4. New media items will be appended to the end of the existing catalog. Also added are each 

itemôs related annotations, label, and thumbnail. Catalog Sets are merged into the open 

catalog. 

Note: If the open catalog already contains files that are part of the selection of files that are 

being merged, Expression Media will ignore these files and will not replicate them. 

 
To merge catalogs using drag and drop 

1. Open at least two catalogs. 

2. Select one or more items in one catalog, and then drag them to the other catalog. If you 

are in List View or Thumbnail View, Expression Media appends the dragged files at the 

location you place the cursor. If you are in Media View, Expression Media appends the 

dragged files to the end of the current catalog. 

3. Using this method does not remove a file from a catalog and add it to another. This 

function only copies the item and its related information. If you want to move the file 

from one catalog to another, hold down the CTRL key (Windows) or the ~ key 

(Macintosh) while dragging.  

Note: If the open catalog already contains files that are part of the selection of files that 

you are dragging, Expression Media will ignore these files and will not replicate them. 

 

To match thumbnail sizes in appended catalogs 

1. After merging the catalogs, select the appended files. 
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2. On the Action menu, click Rebuild Item. 

Importing from a digital camera (Windows) 

Depending on the USB transfer settings of your camera, there are two ways to import images 

from digital cameras. Some digital cameras support a standard called Picture Transfer Protocol 

(PTP). Refer to your digital cameraôs documentation to find out if it supports PTP and how to 

properly define PTP settings for the camera.  

 
To import images using Picture Transfer Protocol 

1. Plug your camera into your computer.  

2. When the dialog box for your camera appears, click the Cancel button.   

3. Launch Expression Media and open an existing catalog, or create a new one. On the File 

menu, point to Import Items , and then click From Disk/Camera.  

4. On the Source menu, select the camera or media card from which you want to import 

media.  

5. Click the Destination folder icon. In the dialog box, select or create a folder to place files 

that are downloaded from your camera. 

6. Select an option according to the following descriptions. 

 

¶ Place in  The option Download folder places downloaded files in the destination 

folder. Todayôs folder places downloaded files in a folder named with todayôs date in 

the destination folder. Origi nal folder hierarchy places downloaded files in a copy 

of the folder directory hierarchy on the camera. 

¶ Rename  Type a text string (such as the date or subject) in this field, and Expression 

Media will rename all downloaded files with sequential numbers following this 

string. Leave this field blank to maintain the existing file names.   

¶ Actions  Select the option Skip files with same name to prevent you from writing 

over existing files with the same name. Set file creation date to capture date sets 

the image fileôs creation date to match the date when you took the picture (Capture 

Date). This option is useful because some applications, as well as the operating 

system, cannot read the capture date. This way, your media will be better organized 

on the desktop. Delete originals after downloading deletes original files off of your 

cameraôs media card after they have been downloaded to the destination folder.   

¶ Annotate  Choose a metadata template from this menu to apply a group of pre-

defined annotations to all downloaded files. If there are no templates available, you 

can create one by selecting New Metadata Template. Clicking the text button next 

to the menu displays the template content and some additional options for applying 

metadata. 

7. Click the Download button. Expression Media will import each image into the open 

catalog after it has been downloaded from the camera to the destination folder you 

defined. After the import is complete, dismount the camera from the desktop (eject), and 

then you can safely unplug your camera. 
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To import without Picture Transfer Protocol  

These procedures also apply to digital media card readers that do not support PTP.  

1. Plug your camera into your computer, or insert your digital media card (Compact Flash 

card, Memory Stick) into your card reader. 

2. When the Device Action dialog box appears, choose Copy pictures to a folder on My 

Computer using Microsoft Scanner and Camera Wizard.  

3. Follow the directions of the Camera Wizard to locate an existing folder or to create a new 

folder for your pictures. On the last screen of the wizard, select Nothing. Iôm finished 

working with these pictures. 

4. Start Expression Media and open an existing catalog, or create a new catalog, into which 

you can import the new images. On the File menu, point to Import Items, and then click 

From Files/Folders. Navigate to and select the folder on your desktop where your 

images were placed with the Camera Wizard.  

5. Click Import . 

Importing from a digital camera (Macintosh) 

The OS X Image Capture application lets Macintosh users automatically download images when 

a camera is attached to the computer. Expression Media has integrated this functionality to make 

cataloging images during download from your camera as easy as possible. 

 
To import from a digital camera on the Macintosh 

1. Start the Image Capture application.  

The application is located in the OS X Applications folder.  

2. Set Image Capture preferences according to your operating system version.  

3. If you are running OS X, open the Image Capture Preferences command. On the 

Camera Preferences menu, select Other. Navigate to and choose Expression Media. 

Quit the Image Capture application.  

4. Plug your camera into your computer. From this point, whenever you plug a camera into 

your computer, Image Capture launches Expression Media.  

5. On the File menu, point to Import Items , and then click From Disk/Camera.  

6. Choose a source from the Source menu, and then select the camera or media card from 

which you want to import media.  

7. Click the Destination folder icon. In the dialog box, select or create a folder to place in 

files that are downloaded from your camera. 

8. Set the options according to the following descriptions: 

¶ Place in  The Download folder places downloaded files in the destination folder. 

Todayôs folder will place downloaded files in a folder named with todayôs date in the 

destination folder.   

¶ Rename  Type a text string (such as the date or subject) in this field, and Expression 

Media renames all downloaded files with sequential numbers following this string. 
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Leave this field blank to maintain the existing file names.  

¶ Actions  The option Skip files with same name prevents you from writing over 

existing files with the same name. The option Lock downloaded files turns on the 

desktopôs lock status for all downloaded files. The option Set file creation date to 

capture date sets the image fileôs creation date to match the date you took the picture 

(Capture Date). This option is useful because some applications, as well as the 

operating system, cannot read the capture date. This way, your media is better 

organized on the desktop. Delete the originals after downloading deletes original files 

from your cameraôs media card when they have been downloaded to the destination 

folder.   

¶ Annotate  Select a metadata template from this menu to apply a group of predefined 

annotations to all downloaded files. If there are no templates available, you can create 

one by selecting New Metadata Template. Clicking the text button next to the menu 

will display the template content and some additional options for applying metadata. 

For more information about creating templates, see ñCustom HTML galleriesò on 

page 97. 

¶ Download  After you have set the options you want, click the Download button. 

Expression Media imports each image into the open catalog after it has been 

downloaded from the camera to the destination folder you defined. After import is 

complete, dismount the camera from the desktop (eject), and then you can safely 

unplug your camera. 

Importing from a CD or DVD 

Use this option to import files from removable storage.  

 
To import from CD or DVD 

1. Open an existing catalog or create a new one.  

2. On the File menu, point to Import Items , and then click From Disk/Camera.  

3. On the Source menu, select the disk from which you want to import media. 

4. Click the Destination folder icon. In the dialog box, select or create a folder for files that 

are downloaded from the disk. 

5. (Optional) To constrain an import to only image file formats, click the Media Importers 

button and select only the Images box. This will prevent non-image files from being 

imported into the catalog. Imports can be filtered by any of eight different media file type 

groups. 

6. Set the options according to the following descriptions. 

¶ Place in  The Download folder places downloaded files into the Destination folder. 

Todayôs folder will place downloaded files in a folder named after todayôs date in the 

destination folder. Original folder hierarchy places downloaded files in a copy of the 

folder directory hierarchy on the Web server in the destination folder. 

¶ Rename  Type a text string (such as the date or subject) in this field, and Expression 

Media renames all downloaded files with sequential numbers following this string. To 

maintain the existing file names, leave this field blank.  
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¶ Actions  The option Skip files with same name prevents you from writing over 

existing files with the same name. Lock downloaded files selects the desktop lock 

status for all downloaded files. Delete originals after downloading moves original 

files to the Recycle Bin (Trash) after they have been downloaded to the destination 

folder. This option will only work on rewritable storage media.  

¶ Annotate  Choose a metadata template from this menu to apply a group of pre-

defined annotations to all downloaded files. If there are no templates available, you 

can create one by selecting New Metadata Template. Clicking the text button next 

to the menu displays the template content and some additional options for applying 

metadata. 

¶ Download  Click the Download button, and Expression Media downloads all files 

from the disk and stores them in the destination you define.  

Importing from the Internet 

You can import any Internet image into your catalog by using one of two methods. You can 

import by entering a URL, or you can use the drag-and-drop operation. To import by entering a 

URL, you must know the exact location of the image file. For example, if there is a site home 

page that contains images that you want to download, just entering the home page URL of that 

site will not download those images. To locate and download specific images from a site, you 

need to know the exact folder where that image resides in the site file structure. 

 
To import a file from the Internet 

1. Open an existing catalog or create a new one. 

2. Do one of the following: 

¶ On the File menu, point to Import Items , and then click From URL . 

¶ Drag the image from the Internet to the Expression Media catalog. 

3. Click the Destination folder icon. In the dialog box, select or create a folder for files that 

are downloaded from the Internet. If you used the drag-and-drop operation, skip to Step 

5. 

4. Type a Web address in the text field at the top of the dialog box. It must be a completely 

formed URL, such as http://www.photo.com/img1.jpg 

5. If applicable, type a cURL command. cURL is a powerful syntax for transferring files 

online.  

Set the options according to the following instructions. 

¶ Place in  Selecting the Download folder places downloaded files in the destination 

folder. Todayôs folder places downloaded files in a folder named after todayôs date in 

the destination folder. Original folder hierarchy places downloaded files as copies of 

the folder directory hierarchy on the Web server into the destination folder. 

¶ Rename  Type a text string (such as the date or subject) in this field, and Expression 

Media renames all downloaded files with sequential numbers following this string. To 

maintain the existing file names, leave this field blank. 

¶ Actions  Skip files with same name prevents you from writing over existing files 

http://www.photo.com/img1.jpg
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with the same name. Lock downloaded files selects the lock status for all 

downloaded files.  

¶ Annotate  Choose a metadata template from this menu to apply a group of predefined 

annotations to all downloaded files. If there are no templates available, you can create 

one by selecting New Metadata Template. Clicking the text button next to the menu 

displays the template content and some additional options for applying metadata. 

¶ Click the Download button. In addition to downloading the Web image, Expression 

Media downloads all files from the Internet, and stores them in the destination you 

defined. Expression Media will also store the fileôs Web address in the Source URL 

annotation field. 

Using folder watching 

Expression Media offers advanced folder watching to monitor all folders that contain cataloged 

media, either on a hard drive or a local network. When new media appears in a watched folder, it 

can be manually or automatically imported to the catalog. 

 

Folder watching is useful for a workflow in which: 

¶ Images are being scanned by batch and saved to a particular folder. 

¶ A ñfolder actionò is automatically downloading images from other computers or the 

Internet. 

¶ Several users are contributing images to a shared network folder. 

 

To import files using folder watching 

1. Click the Organize button. 

2. Select an option from the catalog Folder Watching menu .  

3. Expression Media alerts you when new images have been added to any folder by 

displaying a blue arrow on the folder icon. To import these new images directly to your 

catalog, choose Update Folder Now from the individual folderôs contextual menu. 

4. To enable automatic updating, choose Switch Auto-Update On on the contextual menu 

of the individual folder that you want to be updated automatically. When new images are 

added to that folder or any sub-folder, Expression Media automatically imports those 

images to your catalog. Expression Media adds the new images to the end of the catalog. 

Auto-update folders are colored green. To clear the auto-update feature, but maintain 

folder watching, select Switch Auto-Update Off. 

5. To turn off catalog-wide folder watching, choose Never from the catalog Folder 

Watching menu.  

Protecting your catalogs  

Once you have created a catalog, you might want to prevent others from viewing or accessing it. 

You do this by setting a password. When opening the catalog in the future, you will be asked to 

provide the password before you can view the catalogôs contents. Expression Media does not 

provide a way to recover catalog passwords. 
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Important : Expression Media catalogs do not use encryption for password protection. For 

optimal security, store private catalogs in a secure location, such as your personal documents 

folder. 

 
To set password protection for a catalog 

1. On the File menu, click Catalog Info. 

2. Click the Set Password button.  

This button is only available if you have saved your catalog. 

3. Type a password, and then save the catalog.  

4. To remove password protection, click the Set Password button and delete the password 

in the field. Save your catalog to remove password protection.  

Finding catalogs 

The Catalog Finder lets you quickly locate and preview all Expression catalogs on a storage 

volume (hard drive, CD, DVD, and so on).  

 
To find a catalog 

1. On the File menu, click Recent Catalogs, and then click Catalog Finder. 

2. Select a storage volume from the menu, and Expression Media will locate all catalogs on 

that volume.  

3. To refresh the search, click the Find button.  

4. To preview the found catalog, click a catalog name in the search results list.  

5. To open the catalog, click Open. 

Setting Expression Media preferences 

You can define additional setup and program options in the Preferences dialog box. The 

preferences are divided into several categories. You can access the preferences by clicking the 

Edit  menu, and then pointing to Preferences. Setting some of these preferences requires that you 

have a working knowledge of the features that they control. Use the following indicated 

references to learn about and set the corresponding preferences. 

 

¶ General  These preferences define some of the global display and general behavior 

characteristics of the program. 
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General preferences 

 

¶ Media Rendering  These preferences define how Expression Media processes and 

displays images within its views.  

¶ The Vocabulary Editor  preferences define the terms you use to add annotations to your 

media files. For more information about annotations and about setting these preferences, 

see ñMetadata vocabulariesò on page 43. 

¶ Labels and Colors  These preferences enable you to customize the colors and names of 

labels globally. Color labels provide a method of a visual identification and classification 

of media files in your catalogs. For more information about labels and setting these 

preferences, see ñLabeling your filesò on page 56. 

¶ Helper Applications  These preferences define other applications outside of Expression 

Media that you can use to perform extensive edits on your catalog files. For more 

information about Helper applications and setting these preferences, see ñHelper 

applicationsò on page 116. 

To set general preferences 

1. On the Edit  menu, point to Preferences, and then click General.  

2. Set the options according to the following descriptions. 

¶ At Startup  Choose whether you want to open a new catalog, open the last catalog 

you used, or do nothing every time you start the application. 

¶ Double-click   Choose how Expression Media interprets double-clicking a media item 

in a catalog. 


